SINAMICS G120
with CU240S DP (FW3.2)

Control via PROFIBUS

Application ¢ July 2010

Applikationen & Tools
Answers for industry. S I E M E N S



Copyright © Siemens AG 2010 All rights reserved

Industry Automation and Drives Technologies Service & Support Portal

This article is taken from the Service Portal of Siemens AG, Industry Automation
and Drives Technologies. The following link takes you directly to the download
page of this document.

http://support.automation.siemens.com/WW/view/en/45288241

If you have any questions concerning this document please e-mail us to the
following address:

online-support.automation@siemens.com

SINAMICS G120 (CU240S DP) Control via PROFIBUS
2 V1.0, Beitrags-ID: 45288241


http://support.automation.siemens.com/WW/view/en/45288241
mailto:online-support.automation@siemens.com

Copyright © Siemens AG 2010 All rights reserved

G120_STD_APP1_en.doc

Warranty and Liability

Warranty and Liability

Note

The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these
application examples and other Siemens publications — e.g. Catalogs — the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
("wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of Siemens Industry Sector.
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1 Automation function

1.1

Automation function

Description of the functionality

The SINAMICS G120 drive inverter is a modular inverter system with degree of
protection IP20. It comprises the two function units Control Unit (CU) and Power
Module (PM).

When using the Control Unit CU240S DP, you have the possibility to use the
profibus DP interface. This interface can be used for data exchange between
inverter and control and to run the drive with the control.

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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2 Functionality of the function example

211

2.1.2

2.2

Functionality of the function example

Task description

The SINAMICS G120 is to be controlled from an S7-300 CPU via Profibus.

Solution

In this function example, the control of a SINAMICS G120 (control word and
frequency setpoint) will be demonstrated using an S7-300 CPU and a specific
program example.

This program example comprises an S7 program to control the SINAMICS G120
and the appropriate configuration in the SINAMICS G120.

Structure of the function example

¢ In Chapter 3 the required hard and software components for the function-
examples are shown.

e The download and test of the program examples supplied are described in
Chapters 4 to 5.

e Chapter 6 informs about the key performance date.

¢ In Chapter 7 more detailed information are delivered. These Steps are not
necessary for the commissioning of the function-example and you don’t have
to do these because they are already included in the S7-Program and
accordingly the SINAMICS G120 Project. The given information should help
you with the creation of your own projects.

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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3 Components that are required

Components that are required

An overview of the hardware and software components required for the function
example is provided in the Chapter.

3.1 Hardware components
Component ‘ Type ‘ Order No./ordering data ‘ Qty ‘ Manufacturer
S7 control
Power supply PS307 5A 6ES7307-1EA00-0AAQ 1 SIEMENS
S7-CPU CPU 315-2 PN/ DP 6ES7315-2EH13-0AB0 1
Memory Card MMC 512 KB 6ES7953-8LJ11-0AA0 1
DI / DO simulation module SM374 6ES7374-2XH01-0AA0 1
Profile rail Profile rail 6ES7390-1AE80-0AA0 1
Profibus connector Profibus connector 6ES7972-0BB50-0XA0 2
Profibus cable Profibus cable 6XV1830-3BH10 2m
Drive
SINAMICS G120 Control Unit * CU240S DP F 6SL.3244-0BA21-1PA0 1 SIEMENS
SINAMICS G120 Power Module * | PM240 6SL.3224-0BE21-5UA0 1
Basic Operator Panel * BOP 6SL3255-0AA00-4BA1 1
Motor * Three-phase induction 1LA7060-4AB10 1
motor
As an alternative to the components marked with *, the SINAMICS G120 training
case can also be used that is additionally equipped with a 24V HTL encoder and a
mechanical brake. This training case can be ordered by specifying Order No.
67B2480-0CDO0O.
Note The functionality was tested with the specified hardware components.
Similar components that are different from those listed above can be used.
Please note that in such a case it may be necessary to change the code
example (e.g. setting other addresses).
3.2 Software components
Component Version Order No. / ordering data Qty Manufacturer
SIMATIC STEP 7 o SP5+ | 6E57810-4CC08-0YAS 1 SIEMENS
V4.1 + SP5 + | http://support.automation.siemens.com/
STARTER HF1 WWiview/en/26233208 1
) http://support.automation.siemens.com/
GSD-File CU240S DP V32 WW/view/en/23450835 1

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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4 Configuration and wiring

4 Configuration and wiring

The hardware configuration and connecting-up the function example are described
in this Chapter.

Please carefully observe the following safety information & instructions when using
the SINAMICS G120:

The SINAMICS G120 has hazardous voltages and controls rotating mechanical
parts that can also be potentially hazardous. If the warning information is not
observed or the information & instructions from the instructions belonging to
SINAMICS G120 are not complied with this could result in death, severe bodily
injury or significant material damage.

4.1 Overview of the hardware configuration

P530T CPU SM3T4

230V
SIHAMICS G120

400V

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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4 Configuration and wiring

4.2 Connecting-up the hardware components
42.1 S7-300 control and CU240S DP-F
Ps307 CPU315-2PN/DP SMaT4 S'NSS'E'EDSEFJZU op
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4 Configuration and wiring

4.2.2

PM240 and motor

L1
L2
L3

PE

Il

SINAMICS G120

PM240

PE

Ul
L1

V1
L2

w1 u2
L3

w2

PE

For more detailed information regarding the installation please refer to the SINAMICS G120 Hardware Installation Manual Power
Module PM240. Download from: http://support.automation.siemens.com/WW/view/en/22339653/133300
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4 Configuration and wiring

4.3

4.4

441

Fault 395 (acceptance test / acknowledgement present)

Fault F395 is output when powering-up for the first time and after replacing the
Control Unit (CU) or the Power Module (PM).

This fault does not represent an incorrect drive inverter function. The reason for
this fault message is to monitor the individual drive inverter components (CU and
PM) to prevent them from being replaced by unauthorized personnel.

Acknowledging fault F395

Just like any other fault, it can be acknowledged using an appropriately
parameterized input, via the field bus or using the STARTER parameterizing
software.

Important hardware component settings

Most of the module/board settings are made in the HW Config in the software.
Hardware settings are only required for the following modules/boards.

The modules/boards must be set with the control system in a no-voltage state.
SM374 simulation module

This module can be operated as 16 x DO (output via LED), 16 x DI (input via
switch) or as combined 8 x DI / 8 x DO. The last combination is used in this
function description.

The function of the module is selected using a rotary switch behind the front cover
between the series of switches.

As shown in the following diagram set the function switches to the setting 8 x
Output 8 x Input.

By k’lﬁx[lu’rpuT
Jutpu

Bx
Input rilExInpuT

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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4

Configuration and wiring

4.4.2

12

SINAMICS G120

The Profibus address must be set on the right-hand side of the Control Unit
according to HW Config.

Using the DIL switch, set address 10 as shown in the following diagram.
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4 Configuration and wiring

4.5

Overview of inputs and outputs

451 Simulation module SM374
5 0 | 000 error
5 —_—
a1
o] 2
o] 3
5 &
@] &
8] &
6] 7
i) B
Ry k’l&:ﬂu'ruu’r _
Qutput
B
Input nﬁrlnpur _
o
@ 7 1 0.0 SIHAMICS G120 start
a
@ 1 1 0.1 SIHAMICS G120 reverse
o] 2
@ |=:
Q@ |9+
@ i b 10.5 Increase frequency
@ r—f 10.6 Decrease frequency
0| @ 53 10.7 Acknowledge error
0 | |[g
Address Function Symbolic address | Default Explanation
00.0 Indicator lamp error 0 faults are signaled via this output
error
10.0 SINAMICS Start_G120 0 The motor connecteq to _SINAM!CS G120 is started by
G120 start activating the input
SINAMICS After the input is activated, a negative frequency
10.1 G120 reverse Reverse_G120 0 setpoint is entered (direction of rotation reversal)
10.5 flncrease Increase_frequency 0 The motor frequency can be increased using this input
requency
10.6 ]Pecrease Decrease_frequency 0 The motor frequency can be reduced using this input
requency
10.7 Acknowledge ACK error 0 Fault messages that are prgsgnt can be acknowledged
error — using this input.

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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4 Configuration and wiring

45.2 SINAMICS G120
The SINAMICS G120 is controlled and the feedback signals read-in via the I/O
addresses listed below.
Address Function
S7 program -> SINAMICS G120
PQW256 Control word 1
PQW258 Frequency setpoint
PQW260 Torque setpoint
PQW262 Control word 2
PQW264 -- Reserve --
PQW266 -- Reserve --
SINAMICS G120 -> S7 program
PIW256 Status word 1
PIW258 Frequency actual value
PIW260 Current actual value
PIW262 Status word 2
PIW264 Last fault number
PIW266 Last alarm number

For more detailed information about the configuration of the individual signals,
please refer to SINAMICS G120 Operating Instructions Control Unit CU240S,
Chapter Commissioning.

Download from:
http://support.automation.siemens.com/WW/view/en/22339653/133300

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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5 Download

Download

S7 program

To download the S7 program, you will require a connection between the MPI
interface of your PG/PC and the MPI interface of the S7 CPU.

Start the SIMATIC Manager.
De-archive the function example supplied.
Open the G120_STD_APP1 project.

Select the PROFIBUS interface parameterization using Options > Select
PG/PC interface... .

Open HW-Config and download this into the control. After the download re-
close HW-Config.

In SIMATIC Manager, select the block folder via CPU315-2 PN/DP > S7
Program > Blocks.

Download all of the S7 program blocks into the CPU

SINAMICS G120 (CU240S DP) Control via PROFIBUS
V1.0, Beitrags-ID: 45288241 15
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5 Download

5.2 SINAMICS G120 configuration

When this has been completed, download the SINAMICS G120 configuration using
the STARTER parameterizing tool.

e Starting from the main path of the SIMATIC Manager, start the STARTER
parameterizing software by selecting the SINAMICS_G120 icon and double
click on the Inbetriebnahme icon.

QSIMATI[ Manager - [G120_STD_App_1 -- C:\Siemens},Step 7\, s7projtG120_S_3]

%Eile Edit Insert PLC Wew Options Window Help

O |22 a | & B dalo 25 2 o 2l | & ([ <MoFiters % vaE BED K
G120_5T0_App_1 (bject name | Symbalic name | Type | size | Author | Last madiied | Cor
EHE SIMATIC 300(1) ﬂ Inbetrihriahme Commissioning 061542010 03:21:51 PM )

- =-[@ CPUNEZPN/DP
i B-E7 57-Programm(3)
(B Quellen
--{gH Bausteine

5

e Then, in the Project Navigator of the STARTER parameterizing software select

the object "G120" (1.) and press the button E (2.) to establish the online
connection to the drive inverter.

[P¥STARTER - G120_STD_App_1 - [G120.5INAMICS_G120 - Configuration]

ﬂ] Project Edit Target system Wiew Options Window Help
| D|e|a(5| @l 5|8 <]« el 3 Zlnl=
|89 =l | 2

E"% €120.570_fpp.1 Drive data set: DDS 0 Wwizard...
e ’_| Insert single drive unit

o[ e e | | @ | @ (2] |

Command data set: CDS 0

- SINAMICS_G120
FIVE Navigator

Configuration | Drive data sets I Command data sets | Reference parameter

- > Configuration Name:  [SINAMICS_G120 Coniral e
5= Inputs/outputs

» Setpoint channel In
» oOpen-loop/cosed-loop contral

» Functions
% Messages and manitoring SINAMICS_G120. Cloged-loop contral module Encode

Type: G120 CU2405 DP
Enc. by
Order na.: E5L3244-0BA20-1PAD

Firrnware wersion: 324

» Technology controller
» Commissioning

» Communication

» Diagnostics

[
[
[
[
[
[
[
[

e After you have established the online connection, press the button @l to
download the SINAMICS G120 drive parameters.

e Follow the instructions on the screen and acknowledge the prompt "After
loading, copy RAM to ROM".

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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5 Download

5.3

Exiting the STARTER parameterizing software

If you don't wish to set any additional parameters, then you can now exit the
STARTER commissioning tool.

In the tree select SINAMICS G120 and transfer all of the parameter changes
into the ROM memory of the SINAMICS G120 by pressing the .;| button
Then transfer all of the parameters into your offline a project by pressing the

I@ button.

Disconnect the PG / PC from SINAMICS G120 by pressing the |ﬁ| button.

Now you can close STARTER using Project > Close or by pressing the x|
button.

SINAMICS G120 (CU240S DP) Control via PROFIBUS
V1.0, Beitrags-ID: 45288241 17



6 Key performance data of the SIMATIC CPU

6 Key performance data of the SIMATIC CPU

Load memory and working memory

Total

Load memory Approx. 6 k

Working memory Approx. 2 k

Cycle time

Total cycle time (typical) Approx. 1ms

Copyright © Siemens AG 2010 All rights reserved
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7 Background information

7.1

Background information

The individual functions of the example code are explained in the following
Chapters so that you will then be in a position to implement your own project.

For this function example, the settings described no longer have to be made.

Settings in the hardware configuration

E{-,I:Hw Config - [SIMATIC 300{1) {Configuration) -- G120_STD_App_1 - |EI|£|
E“| Station Edit Insert PLC Wiew Options MWindow Help _|ﬁ’|£|

DE%" 5| S [2e | dada e BN

=0 UR j

PS5 307 5A -
CPU 315-2 PN/DP
MADP

PN

Poaif ¥

PROFIBIUS[1): DP-Masterspstem (1)

DI18/D08-DC24Y/0,54

iy

-
4| | »

:|Z| () UR

Order number Carmrnent

i07-1EA00-0880
GES57 315-2EH13-0AB0D
A
YRR
YA
4_3 DI3/D03sDE24 20,84 |BEST 323-1BHO1-0440 0 I
5
5
7
8
: &l
Press F1 ko get Help, v

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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7.1.1 Properties of the SINAMICS G120

The window of the SINAMICS G120 PROFIBUS properties (2.) is displayed by
clicking once on the SINAMICS G120 icon (1.).

ﬂJ;:Hw Config - [SIMATIC 300(1) {Configuration) -- G120_STD_App_1] - |EI|5|

E"] Station Edit Insert PLC  View Options ‘Window Help _|E|i|

D@ G 2 dada bS58 w

PS 307 Bé& -
CPU 315-2 PN/DP
MNP

P

Porf ¥

|

PROFIBUS[T): DP-Masterspstem (1]

DI8/D08D 240,54

-1

-
a| | 3

ﬂ:l [10] SINAMICS CLU2405 DP W32

_E LEIL Dudarblurberd Diasignation 1Adde 0L Lomment I
' 1 117 Universal module 286267 [2BE..267 |
3 2.
4
Press F1 to get Help, | | v

The PROFIBUS telegram (2.) between the CPU and the SINAMICS G120 is the
Standard Telegram, in this particular example, Universal module (free telegram
configuration) for the communications of the SINAMICS G120 (control signals,
status signals, frequency setpoint, frequency actual value etc.)

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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The telegram is selected in the Catalog after pressing the button.

Brafile: I Standard

EI--%'HI PROFIBUS DP
Bl Additional Field Devices
= Drives
=13 SINAMICS

E SINAMICS CU2400 DF W32
(SR S NAMICS CUZ405 DP V32
; Univerzal module
Standard telegram 1
Standard telegram 20
SIEMENMS telzgram 350
SIEMEMS telegram 352
SIEMEMS telegram 353
SIEMENMS teleagram 354
E]---E SIMNAMICS CU2405 DP F w32
[]---E SINAMICS G120
o7 Switching Devices
g 1/0
1] Gateway
v-[_7] Compatible PROFIBUS DP Slaves
----- a CiR-Object
-] Closed-Loop Controller
-] Configured Stations
E-0 DP WD slaves
- DP/ASH
[ DP/P4 Link
-1 ENCODER
- ET 2008
-] ET 200C
-1 ET 200eco
- ET 200i5
[ ET 200iSF
-0 ET 2001 |
B ET 200M
[
[
[
[
[
[#
[
[
[
[
[

Bl x|
End | “ﬂ "":!l
|

£
£
[E
E

71 ET 200pro

7 ET 200R

A ET 2005

7] ET 200U

b7 ET 200

7.1 Function Modules

7] IDEMT

f- IPC

7 NC

77 Metwark Components

7] Sensor system

[ i WAL RPN | ll
ESL3 244-0BA20-1PAD H
OP-Slave SIMAMICS G120 CU2405 DP «3.20 with DP- -
"1 interface [cyclic and acyclic communication).

| I [ 4

You can download the GSD files for the SINAMICS G120 under the following link:
http://support.automation.siemens.com/WW/view/en/23450835

GSD files are required to operate a node (e.g. the SINAMICS G120) on
PROFIBUS — and to register (log-on) the device to the engineering tool.

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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7 Background information

7111

Standard Telegram
x|
Address /1D |
[I.-"EI Type: - ] 1 . Direct Entry. .. |
— Clutpat
Addrezs: Length: Lnit: Conzistent over:
Stat: 256 6 = fwods =] |Uni =l
End: 267 .,
L1}
Process image: |EIB1 Pl j
e
— Input
Addrezs: Length: Irit: Conzistent over:
Start: 206 |E = IWu:uru:Is j ILInit j
End: 267 3._.
Process image: |DB1 Pl j
b
Manufacturer-specific data:
[Maximum 14 bytes hexadecimal, zeparated by camma ar blank space|
Cancel Help
Various pre-assigned telegrams and a freely parameterized telegram are available
for this communication; these can be selected from the hardware catalog.
The freely parameterizable telegram (Universal module) can be used in this
function example. This has the advantage that the telegram structure can be freely
adapted to the particular application.
Analog to HW-Config, this telegram selection must also be made in the SINAMICS
G120 (refer to Chapter 6.5).
(1.) To parameterize the telegram, first select an Out-input range for I/O Type.
(2. and 3.) Then, when using the Universal module, the telegram length must be
defined for the send and receive directions. In this example, a length of 6 Words is
parameterized for sending (Output) and 6 Words for receiving (Input) - from the
starting address 256.
- SINAMICS G120 (CU240S DP) Control via PROFIBUS
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7.2 Functions of the Step 7 program
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7.2.1 Program overview
DE1
Axis_DB G120
FB10
OB1 Organisation Cn:tg%alzn
Provide the

CALL FB1D ——

Controbword 1/ 2,
Frequency- and
Torgue Sefpoint

Activation of the
indication lamp
for error

Read staluswords
out of the G120 and
transfer to the Axis-

oa

Read emor- and
alarmnumber out of
the G120 and
transfer to the Axis-

Read controlwords

aut of the Axis-DB

and transfer to the
G120

The Step 7 program essentially comprises blocks FB10, FC100 and DB1 that are
called in the cyclic program (OB1).

SINAMICS G120 (CU240S DP) Control via PROFIBUS

V1.0, Beitrags-ID: 45288241

23



Copyright © Siemens AG 2010 All rights reserved

7 Background information

7.2.2

DB1, Axis_DB

The Axis_DB represents the interface between the S7 program and the SINAMICS

G120 via FC100.

Axis_DB is generated from UDT 1 (Axis_DB_G120)

Principal structure of Axis_DB:

Address Symbolic name Type Function
Internal data
DBWO Basic_Data.Moduleadress INT | I/O start address of the SINAMICS G120 (refer to
HW Config)

DBB3 Basic_Data.Drivetyp Byte | Drive type, must be 2

S7 -> SINAMICS G120
DBW4 Control_signals.STW2 Bool | Control word 2 (for details, refer to the S7 program)
DBW6 Control_signals.STW1 Bool | Control word 1 (for details, refer to the S7 program)
DBW8 Control_signals.Frequency_set INT | Frequency setpoint in x.x %
DBW10 | Control_signals.Torque_set INT | Torque setpoint in x.x %

SINAMICS G120 -> S7
DBW14 | Status_signals.ZSW2 Bool | Status word 2 (for details, refer to the S7 program)
DBW16 | Status_signals.ZSW1 Bool | Status word 1 (for details, refer to the S7 program)
DBW18 | Status_signals.Actual_frequency INT | Frequency actual value in x.x %
DBW20 | Status_signals.Actual_current INT | Current actual value (Value from SINAMICS G120)
DBW?22 | Status_signals.Actual_current_A INT | Current actual value in x.xx A

Error messages

DBW24 | Faults.Drive_error_number INT | Actual error number of the SINAMICS G120
DBW26 | Faults.Drive_alarm_number INT | Actual alarm number of the SINAMICS G120

In this function example the individual data of the DB1 are supplied in FB10.
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7.2.3 FB10, Organization

This block is called-up in absolute terms in OB1 and in turn calls up FC100.
Principle of the FB10

Network Function

1 Calls the FB11 to generate the frequency setpoint

Controls the SINAMICS G120 via the axis-DB, DB1.

Calls the SINAMICS G120 control block FC100.

2
Provides the feedback signals — incl. error and alarm number
This network can be used as template for additional SINAMICS G120 control functions.
3 Controls the signal lamp for fault.
7.2.4 FC100, Control of SINAMICS G120

SINAMICS G120 is controlled using the FC100 via PROFIBUS.

Only signals from the Axis_DB are used to control the block - but no fixed
addresses - this is the reason that instances can be used.

This block can be used in the same way for both a standard and a Safety
SINAMICS G120.

Formal operands of the FC100

Formal operands Type Description

Nr_Axis_DB IN Number of the Axis-DB generated using UDT1

Copyright © Siemens AG 2010 All rights reserved

Displays an internal error
Internal_Error ouT 0 =no error
1 = incorrect Axis-DB type (wrong UDT)

Principle structure of the FC100

Network Function
1 Opens the Axis_DB specified using the formal operands Nr_Axis_DB.
Generates the internal error message.
2 Re_ads-in the SINAMICS G120 status words, processes these and saves them in the
Axis_DB.
3 Resets internal error messages.
4 Converts frequency and torque setpoint from the Axis_DB (entered in x.x %) into the

SINAMICS G120 format (hex).

Enters SINAMICS G120 error and alarm number into the Axis_DB.

Sends control words from the Axis_DB to the SINAMICS G120

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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7 Background information

7.3

7.3.1

SINAMICS G120 parameterization

SIMATIC Manager - inserting SINAMICS G120

¢ In SIMATIC Manager select the tree G120 _STD_App1l and using Insert >
Program > SINAMICS select a SINAMICS G120 type object.

QSIMATIE Manager - [G120_STD_App_1 -- C:4Siemens',Step7\s7proj'G120_5_3]

@Eile Edit Insert PLC “iew Options ‘Window Help

D B4 B dls %) i

== ‘ || < Mo Filter »

DY ReE BED W

3 G120_5TD_App 1 Object name
E‘ SIMATIC 30001) E Inbetriebnahme

| Type | Size | Author | Last modified | car
= e,
Commigsioning 06/15/2010 03:21:51 P )

CPU 315-2 PN/DP
=-{z2] S57-Programm(3]
{B] Ouellen
{28 Bausteine

 FEm

e Make the following settings and press the OK button.

Insert single drive unit x|

General  Drive Unit # Bus Address |

Device family: I CIMAMICS j
Lizsiz= | SINAMICS G120 =l
Device characteniztic:

Characteristic | Order no. |

CUZ30P-2 CAM BSL3 24 3-wumm-uCn

CUZ30P-2 DP BSL3 24 3-wumm-uPn

CUZ30P-2 HWALC BSL3 24 3-smmm0-sH

CLUz240 BSL3 2dd-mmmm-wa
Werzion; I Ry j
Online access: IF'FH:IFIELIS j
Address: |-||j j
Slat: 2 =i

Cancel | Help |
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7 Background information

7.3.2

7.3.3

Calling the STARTER parameterization tool

e Starting from the main path of the SIMATIC Manager, start the STARTER
parameterization software by selecting SINAMICS_ G120 and double click on
Inbetriebnahme.

HSIMATIE Manager - [G120_Safety_App_2Z_W20 -- C:\Siemens\Step 7 s7proj G120_§ 1]
%Eﬂe Edit Insert PLC View Options Window Help

b

O |22 4 B idallz 32 o &[] m [ <NoFiher Y| aE 2EMm|

El-E=p G120_Safety_dpp_2 %20 | Objsctname | Symbolic-name | Typ
- SIMATIC 300(1) (5! Inbetiebrahme Commissioring 06/15/2010 032151 PM

- B[ U nse2 PHDP
H E] S7-Programm{3]
{B Suellen
‘(g8 Bausteine

@ G120

e Then, in the Project Navigator of the STARTER

parameterization software select the object G120 (1.) and press button E (2.)
to establish an online connection to the drive inverter.

iw"'STARTER - G120_STD_App_1 - [G120.5INAMICS_G120 - Configuration]
B Project Edit Target system Misw Options Window Help

T e T e L -V O
|5

[zl | 2,

E--% G120_5T0_App_1 Drive data st DDE 0 Yfizard...

%] Insert single drive unit Command data set. CDS 0

Canfiguration | Dirive data setsl Cornmand data sets | Reference parameter

Mame: |SINAMICS_G1ZD Cantral typ

%= Inputsfoutputs
- Setpoint channel In

- % Open-loopfclosed-loop control
- % Functions
- % Messages and monitoring

=3 Techn.o\o.gy.contmller = Type: G120 CU2405 DF
- Commissioning sz Enc. ty
Order no.: B5L3244-0BA20-1PAD

SINAMICS_G120.Closed-loop contral module Encade

- % Communication
- % Diagrostics

[ - [

Firmware version: 324

STARTER - carrying out quick commissioning

e The screen form with the actual configuration is opened by double clicking on
Configuration in the Project Navigator.

e The quick commissioning Wizard is started after pressing the
wizard... button.

e Enter the appropriate values into the Control structure to Encoder screen
forms. You can call-up corresponding help texts in the individual screen forms
by pressing on the Help button.

e Inthe screen form Drive functions, select for Motor identification, the
function Ident. of al param. in standstill incl. the saturation curve (3).

e Enter the corresponding parameters into the Important parameters screen
form.

¢ Inthe screen form Calculation of the motor data, select Restore factory
setting and calculate motor data.

e Inthe screen form Summary do not activate the function RAM -> ROM, but
instead press the Finish button.

SINAMICS G120 (CU240S DP) Control via PROFIBUS
V1.0, Beitrags-ID: 45288241 27



Copyright © Siemens AG 2010 All rights reserved

7 Background information

7.3.4 STARTER - carrying out a motor identification routine

e After completing the quick commissioning, alarm A0541 (Motor data-
identification active) is displayed. Please carefully note that when starting the
motor identification routine current flows in the motor. For hanging (suspended)
axes the load must always be supported.

e To start the motor data identification routine, in the Project Navigator select the
menu item Commissioning and activate by double clicking on Control panel.

[Sinenics_a1z0- G120 =] IEIE Heh |
| Assume contral priorityl l j ﬂ v F setpoint specification  mm— .'—. :
s: [ o fe - Hz 0% g 00 2= 200%
™| Enables DDS: l_lj l— Hz
Enables available [1] Drive ready
© " C0: Freq_ setpoint before RFG =l
Diagriostics Specified Actual
Output frequency: | 15_uu| 0.00 Hz 15.00 Hz
OM JOFF1
8 ON /0FF 2 e || ] I i 0 Act fikered frequency =l
ON /OFF 3
Pulse enable 0.00 Hz |
Riamp-function gen. enable
8 Ramp-funclion generator start T — 000 A
Setpoint enable
d Irvverter load 0o

e Press Assume control priority and carefully note the security/safety
information and instructions. Then activate Enables.

[EiNemIEs_G120- G120 =] |il@ Hep |
Give up cantrol priority! ﬂ . Ayl f setpoint specification 1 i - - .|—‘ -
s [0 ':Hz 02 [ 00 x - 2003
[V Enables ops: [ 0 T
C Enables avallable [1] Drive ready
" CO: Freq. setpaint before RFG j
Diagrosics_| Specified Actual
Output frequency: | D_UUl 0.00 Hz 0.00 Hz |
OM /OFF 1
i 0.00 0.00 M
8 ON /0OFF 2 CIL1= I I " CO: Act. filtered frequency j
ON /OFF 3
Pulse enable 0.00 Hz |
Ramp-function gen. enable
Famp-function generator start Motor current 000 A
Setpaint enable
d Inverter load: oo %

e 1)) If the Control panel isn't completely displayed on your PG/PC, then press
the &? button.

e The motor data identification routine is started by pressing the D button. Do
not exit the STARTER software and go to another task as otherwise the motor
data identification routine will be interrupted for safety reasons.

e Please wait until the D button changes back to the . button.

e Return the control priority to the S7 control by pressing the
Give up contral priarityl | button.

SINAMICS G120 (CU240S DP) Control via PROFIBUS
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7.3.5 STARTER - setting the Profibus communications

e Communications between the CPU and the SINAMICS G120 must then be
parameterized. To do this, open the screen for the communication settings
using Communication -> Profibus. Select the tab Transmit direction.

e To start, select the Standard-Telegram 350 (350) from Message frame: (1.).
This pre-assigns the telegram.

[“"-'STARTER -G120_STD_App_1 - [G120.5INAMICS_G120 - PROFIBUS]

&] Project Edit Target system Wiew Options Window Help

| D@ 8 &=l o[~ ] 1=

A A EE | T T

=

=& 6120_5TD_App_1
% Insert single drive unit
=-fla G120
™ Configure drive unit
B ] SIMAMICS_G120

Receive directio

(Massage frame: I[SSD] Standard Telegram 350 j ] 1 .

[~ Suppress inactive interconnections

-3 Drive navigator fa)
- » Configuration ’\'
%= Inputsfoutputs ]
[~ ¥ Setpoint channel s 2 Z5w1 | 1
- Open-loopjclosed-oap control _
[#- ¥ Functions > fia (| MIST_A_GLATT |£|
- % Messages and monitoring s = [ 1aIsT_GLaTT |i|
- Technology controller
[~ ¥ Commissioning g 2 252
[=- ¥ Communication > jfoz ]
- » PROFIBUS H |E|
[~ ¥ Diagnostics

e Then replace telegram 350 by telegram type Free BICO connection (999) (1.).
Deactivate any possibly active Suppress inactive interconnections function
(2.) and establish the following interconnections (3.):

e PzZD 5 =r2131 (Last fault number code)
e PZD 6 =r2132 (First warning number code)

[&“""STARTER -G120_STD_App_1 - [G120.5INAMICS_G120 - PROFIBUS]
@ Project  Edit  Target system Wiew Opfions ‘Window Help

| D|s|E% & 4=l o« ]| =]l

|| | || @ @] | 2|5 | -

TN

=

=P G120_5T0_App_1
-] Insert single drive unic
=lls 6120
- Configure drive urit
B SIMAMICS_G120
»ﬁ- Drrive navigakor
- » Configuration
S Inputsjoutputs
- Setpoint channel
-3 Open-loop)closed-loop contral
-3 Functions
- Messages and monitaring
-3 Technology contraller
-3 Commissioning
-3 Communication
LS Interfaces
> PROFIBUS
1 3 Diagnostics

-

o
[0 G e ][] ]

=]

!lr2?: C0: Act. output current
!I 153 CO/BO: Act. status word 2 Z
ilr?l 31: CO: Last fault number code i
[!Q‘I 32 : CO: First warning number c m] 3
=
v

Receive direction  Trarsmit direction |

@essage HENME 999 Free BICO connection ] 1 .

(I' Suppress inactive interconnections] 2

,l 121 : CO: Act. filtered frequency
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e Finally, you only have to save the SINAMICS G120 configured software in the
ROM memory of the drive inverter. To do this in the Project Navigator select
the menu item SINAMICS_G120

e In the function bar press the |3| button.
e Please wait until the download operation has been completed.
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8 Appendix

8.1 Internet link data
Subject area Title

Link to safety items http://support.automation.siemens.com/WW/view/
en/20810941

SINAMICS §120 http://support.automation.siemens.com/WW/view/

Documentation en/22339653/133300

Siemens customer Customer Support

support homepage

SINAMICS G120 http://www.automation.siemens.com/mcms/standa

Homepage rd-drives/en/low-voltage-inverter/sinamics-
g120/Pages/sinamics-g120.aspx

8.2 History

Version Datum Change

V1.0 July 2010 First edition
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